
In an effort to enhance technology in classrooms across the UMHB campus, Info-
Tech has teamed up with UMHB Facilities and the Office of the Provost to outfit 
classrooms with much-needed technology upgrades. 

Phase I of the project, completed during the summer and first part of the fall, called 
for upgrading  28 classrooms with ceiling-mounted data projectors and instructor-
friendly teaching stations that will allow for instruction via desktop computer, lap-
top, VCR, DVD, and the Internet. Larger classrooms will also receive audio amplifi-
ers.  

Phase II of the project is scheduled for the summer of 2008. When complete, all 
classrooms on the UMHB campus will enjoy permanently installed technology to 
enhance learning and teaching goals. 

In designing the layout, configuring the units, and evaluating the equipment needs, 
collaboration with faculty was essential. Members of the Dean’s Council provided 
especially important feedback. 

 

Shawn Kung, the Director of IT, who also served a the lead on this project, noted 
that “after we implement Phase II, all AudioVisual connectivity in the classrooms 
will be unified.” Such standardization will enhance both instruction as well as sup-
port, with faculty and InfoTech staff needing to become familiar with only one lay-
out.  

The Classroom Technology Project was a direct response to expressed needs by 
UMHB faculty to have appropriate technology resources in the classroom. The pro-
ject is also a tactical activity related to UMHB Strategic Planning Goal VI (h): Pro-
vide adequate technological resources across campus. 

 

 

Academic Technology 
Support Specialist, Syl-
via Low, shows off the 
new instructor stations 
that are being installed 
in 28 classrooms 
around campus. 

Each classroom up-
grade will include a 
teaching station with 
pc, dvd, vcr, and au-
dio, as well as a ceiling 
mounted data projector 
and new whiteboard. 

Classroom Technology Upgrades Abound 

InfoTech Expands  

Helpdesk Hours 

In an effort to serve you 
better, InfoTech will offer 
evening phone support. 

Fall 2007 phone support 
hours are: 

Mon—Thu: 8am to 10pm 

Fri:  8am to 5pm 

Contact us at 295-4658 
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InfoTech welcomes  new 

Academic Technology 
Support Specialist 

Sylvia Low joined Info-
Tech this past summer to 
provide academic technol-
ogy support for  faculty 
using the myCampus 
Learning Management Sys-
tem and other educational 
software. 

Please join us in welcom-
ing her to UMHB! 



Interested in  getting the 
Microsoft Office suite of 
programs or a Dell com-
puter but the price seems 
out of reach?  

Thanks to a special ar-
rangement between UMHB 
and it s vendors, you can 
enjoy significant discounts 
on a variety of popular 
hardware and 
software.  

UMHB’s partici-
pation in the 
Dell University 
Program can net 
you savings of 
up to 12% on 
personal com-
puting equip-

ment. To find out more, visit 
www.dell.com/umhb. Or you 
may call 1-888-987-3355 and 
reference the following UMHB 
Member ID: US 29741762.  

Or if productivity software is 
your thing, check out our online 
brochure about savings for both 
PC and Mac users: 
www.umhb.edu/files/

technology/
campus_tech_flyer.pdf   

For example, Microsoft 
Office 2007 Professional 
lists for around $400. But 
members of the UMHB 
community can purchase it 
for only $84.85. 

 

Information Technology 
& Systems program.  

InfoTech’s Academic 
Technology Support 
Specialist, Sylvia Low, 
will collaborate with Dr. 
Last to provide training 

on and follow-up sup-
port for faculty wishing 
to use the Learning Man-
agement System (LMS) 
portion of myCampus.  

The Center for Excel-
lence in Learning and 
Teaching (CELT) has 
been established in the 
Townsend Memorial Li-
brary to enhance faculty 
development opportuni-
ties.  

 

The CELT 
complex will 
house a 12-
computer 
workstation 
learning lab, a 
24-seat teach-
ing lab, a fac-
ulty work-
space, and the 
director’s of-
fice.  

 

Dr. Mary Last has been 
appointed the Director 
of CELT, in addition to 
her duties as a faculty 
member in the Business 

Information about CELT 
training workshops can 
be found on the InfoTech 
Training Workshops 
page at: http://
www.umhb.edu/
resources/technology/
workshops.html  

Dr. Graham Hatcher, 
Provost and Vice Presi-
dent for Administrative 
and Academic Affairs, 
notes that “CELT is es-
sential to our mission of 
being a Christ-centered 
learning community.”  

Establishing  CELT 
represents a realized 
objective of the UMHB 
Strategic Planning Goal 
of Enriching Our Faculty 
and Staff.  

For more information, 
contact Mary Last at 
mlast@umhb.edu. 
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Why Pay More?  

CELT to Coordinate Faculty Development 
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“CELT is essential to 

our mission of being a 

Christ-centered 

learning community.” 

-Dr. Graham Hatcher 

UMHB Provost and 

Vice President of 

Administrative & 

Academic Affairs 

 

CELT is the new 

Center for Excellence 

in Learning & 

Teaching. It is housed 

in the Library and 

under the direction of 

Dr. Mary Last 

     Dr. Mary Last, Director of  CELT 



Do you use a popup 
blocker when you surf the 
web?  

Many web visitors, per-
haps even most of them, 
block those extra, un-
wanted windows these 
days and don't think twice 
about it. Popup blockers 
are not only available as 
plug-ins offered by sites 
such as Google and Ya-
hoo!, they're now a stan-
dard feature on the most 
recent generation or two 
of web browsers. 

But not all popups are bad. 
Educational, government 
agency and other non-
commercial web sites oc-
casionally use them to 
enable interactive features 
on their sites. By blocking 
popups, you lose full ac-
cess to these features and 
create more inconven-
ience than you save your-
self. 

At UMHB, for instance, peo-
ple who use CMS to update 
departmental web sites 
report error messages 
when they try to use certain 
tools while their popup 
blockers are turned on.  

Here’s how to enable 
popups at sites you visit 
frequently and know are 
safe from those annoying 
ads: 

In Internet Explorer:  

In the browser menu, go to 
Tools > Internet Options 
and click the Privacy tab 
on the dialog box that 
comes up. At the bottom 
you’ll see the Block 
Popups check box. Click 
on the Settings button next 
to it, and a second dialog 
box will come up. Where it 
says Address of Web site 
to allow, add the URL (such 
as http://www.umhb.edu), 
then click the Add button.  

When you’re done adding 
sites, click Close, then 
click OK on the original 
dialog box. 

 

In Mozilla Firefox:  

In the browser menu, go to 
Tools > Options and click 
the Web Features icon on 
the dialog box that comes 
up.  

Next to the Block Popup 
Windows check box there 
is a button that says Al-
lowed Sites. Click on it and 
a second dialog box will 
come up. Add the sites you 
want to allow, click OK on 
each of the dialog boxes. 

Another new component of 
Office 2007 is the “Microsoft 
Office Button.” Don’t be 
fooled by this icon:  it’s more 

than Window 
dressing! 

The Microsoft 
Office Button 

allows you to do many things 
that the “File” menu did in 
earlier versions of Office 
applications, such as Save, 
Print, and Close.  It is also 
the gateway to performing 
other tasks such as assigning 
permissions and quickly 
moving the document to 
another folder.  

Visit InfoTech’s Office 2007 

During the summer and 
early part of the fall 2007 
semester, InfoTech is roll-
ing out Microsoft’s latest 
productivity suite, Office 
2007, on faculty, staff, and 
lab computers.  

Office 2007 offers users a 
brand new look and feel 
that makes finding what 
you want to do much easier 
than in previous versions. 

A key feature in this new 
look is what Microsoft calls 
the “ribbon.” The ribbon 
represents a new way of 
laying out program fea-
tures based on  feedback 
from users like you and me. 

Lifesavers web page for links 
to easy-to-use interactive 
guides and tutorials: 

http://www.umhb.edu/
resources/technology/
resources/office2007/
lifesavers.html 

 

Popup Blocker Tips n Tricks 

Office 2007 Rollout 
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Are you new to 
Office 2007 and 
need support at 
your fingertips?  

 

Visit InfoTech’s 
Office 2007 
Lifesavers web 
page for links to 
easy-to-use 
interactive guides 
and tutorials: 

 

http://
www.umhb.edu/
resources/
technology/
resources/
office2007/
lifesavers.html 

 

 



AVP Corner...Welcome to the first installment of “What’s Up with InfoTech?” We 

look forward to sharing some of our projects with you and keeping you up-to-date 

with technology at UMHB. For example, during the summer and first part of fall 

2007, InfoTech staff installed more than 700 19” flat panel monitors; outfitted 28 

classrooms with new technologies; rolled out Office 2007 to faculty, staff, and ad-

ministrators; quadrupled the bandwidth available on campus; and reached more 

than 400 students through Success in Academics classes;  In addition, this fall we 

will be experimenting with expanded helpdesk hours during weekday evenings. 

Call us at 254-295-4658 and let us assist you. Also, check out our new online re-

sources at: http://www.umhb.edu/resources/technology.html   

Best regards,  

                                                                                                                             

Associate VP for Technology 

For the latest 
technology training 

workshops, visit: 
http://

www.umhb.edu/
resources/technology/

workshops.html 

that curbs P2P file shar-
ing applications such  as 
BitTorrent, Gnutella and 
others. By throttling P2P 
on campus, UMHB is tak-
ing a proactive stance 
and following the lead of 
other leading universi-
ties. Institutions that 
have not implemented 
devices to block P2P will 
likely soon be required 
to do so or risk being 
liable for their students’ 
illegal P2P activity.  

Steven Marks, general 
counsel for the RIAA re-
cently noted: "While our 
lawsuits three years ago 
initially focused on 
egregious infringers 
(those with hundreds of 
files available), today 
we do not have any 
minimum amount of files 
in order to move for-
ward with a lawsuit."  

One open question for 
higher education is the 
ways in which P2P can 

Over the past several 
months, student use of 
Peer-to-Peer (P2P) file 
sharing applications 
has become a hot topic 
on college campuses 
nationwide.  

The Recording Industry 
Association of America 
(RIAA) has launched an 
aggressive campaign 
to flesh out and prose-
cute illegal song and 
movie swappers. 
Among others, the Uni-
versity of Ohio has 
been particularly hard 
hit. In early 2007 the 
RIAA sent more than 80 
pre-litigation letters to 
students on that cam-
pus. 

In an effort to comply 
with RIAA directives 
and to maximize band-
width for all campus 
users, UMHB has im-
plemented a network 
management device 

be used for legitimate 
purposes. Debate is ex-
pected to continue for 
some time on this issue. 

Follow this topic and 
other higher education 
technology issues on the 
web at: http://
chronicle.com/
wiredcampus 

For a primer on the 
RIAA’s pre-litigation let-
ter and what  users need 
to know, see materials 
prepared by Cornell 
University at: http://
www.cit.cornell.edu/
policy/memos/riaa.html 

Controlling P2P a Hot Topic on College Campuses 

Did You Know? 
 

In an effort to respond 
to the growing 

demand for 
bandwidth, UMHB 

recently quadrupled 
the size of our Internet 

pipe available for 
students, faculty, and 

staff.   

Need tutorials, guides, and 
other resources?  

Check out the InfoTech 
Resources Page at: 

http://www.umhb.edu/
resources/technology/

resources 

 

InfoTech would like to 
congratulate Chris Web-
ster, whose position was 
recently re-classified 
from Web Services Engi-
neer to Webmaster to 
reflect the increasing 
skills and responsibilities 
of the position and the 
growing emphasis on the 
UMHB web presence. 

Got Feedback? 
 

Let’s hear from you! 
Email us at 

infotech@umhb.edu 
with your comments, 

suggestions, and ideas 


